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Subject CP2
CMP Upgrade 2024/25

CMP Upgrade

ActEd often produces a free CMP Upgrade, which provides details of changes to the Syllabus and
ActEd materials.  This year, however, there are some significant changes to the Course Notes and
it is therefore not practical to produce a full upgrade for these.  Changes to the Syllabus and ActEd
materials, along with the level of detail in this Upgrade are as follow:

 Syllabus – no changes

 Course Notes – significant changes, outlined in this Upgrade

 X Assignments – minor changes, full details in this Upgrade

 Mock Exam – no significant changes

Subject CP2 continues to have no Core Reading, so the Course Notes provide guidance on the
techniques required to pass the exam, with explanations of how this links to the Syllabus.  For
2025, the updates to the Course Notes involved streamlining certain chapters and drafting a small
amount of updated content.  The updated content is provided in this Upgrade.  However, given
the practical difficulties of providing full details of streamlined content, only an outline of this
information is provided.  Given there are no changes to the Syllabus, studying the longer 2024
versions of these chapters will not have a negative impact on your chances of passing the exam.

We offer a full set of up-to-date Course Notes / CMP at a significantly reduced price if you have
previously bought the full-price Course Notes / CMP respectively in this subject.  Please see our
2025 Student Brochure for more details.

We only accept the current version of assignments for marking, ie those published for the
sessions leading to the 2025 exams.  If you wish to submit your scripts for marking but only have
an old version, then you can order the current assignments free of charge if you have purchased
the same assignments in the same subject in a previous year, and have purchased marking for the
2025 session.
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1 Changes to the Course Notes

Overall

This section contains an outline of the changes made to the Course Notes.

Chapter 1

Section 1.3

Some detail about chi-square tests that was previously included in Chapter 6 has been moved
here.

Chapter 4

Section 2

This ‘Examples of good/bad summaries’ section has been replaced with a new section,
‘Methodology’, which is about documenting methodology in a summary document.  Replacement
pages can be found at the end of this Upgrade.

Section 3

The question in this section has been streamlined and simplified in order to focus on CP2
techniques rather than the complex scenario.

Chapter 6

This chapter has been amended and streamlined significantly.  Section 1 on ‘Basic Excel
operations and tasks’ has been removed, section 3 on ‘Excel charts’ has been streamlined and the
remaining content has been restructured.

Details of Excel functions that are not permitted in the CP2 exam have been added.  In the 2024
version of the Course Notes, this would be between sections 2 and 3.  A replacement page can be
found at the end of this Upgrade.

Details of more Excel functions have been added.  This includes some new tables about basic
statistical functions and statistical distribution functions in section 2 (2024 Course Notes), plus
some more detail on array functions in section 4.  Replacement pages can be found at the end of
this Upgrade.

Chapter 7

Chapter 7 has been streamlined and section 1 on ‘Basic Word operations and tasks’ has been
removed.  Some additional guidance on writing mathematical formulae in Word has been added
into section 3 (2024 Course Notes).  A replacement page can be found at the end of this Upgrade.
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2 Changes to the X Assignments

Overall

There have been minor changes throughout the assignments.  More significant changes are listed
below.

Assignment X1

On page 1 of the questions document, the question wording for parts (iii) and (iv) has been
updated to correct minor errors in referencing previous question parts.  Replacement wording is
as follows:

(iii)  (a)  Calculate the mean and sample standard deviation of the simulated claim
numbers from step (ii). [2]

(b)  Calculate the expected mean and standard deviation of the claim distribution
above. [2]

(iv) Perform a check comparing the results from part (iii). [2]

Assignment X2

The Assignment X2 written solution has been amended significantly and replacement pages can
be found at the end of this Upgrade.  The solution spreadsheet has not changed significantly.

Assignment X3

Some additional explanation has been added to the audit trail on page 6 of the questions
document.  A replacement page can be found at the end of this Upgrade.
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3 Other tuition services

In addition to the CMP, you might find the following services helpful with your study.

3.1 Study material

For further details on ActEd’s study materials, please refer to the Products pages on the ActEd
website at ActEd.co.uk.

3.2 Tutorials

We offer the following (face-to-face and/or online) tutorials in Subject CP2:

 a one-day Tutorial

 an Online Classroom.

For further details on ActEd’s tutorials, please refer to our latest Tuition Bulletin, which is available
from the ActEd website at ActEd.co.uk.

3.3 Marking

You can have your attempts at any of our assignments or mock exams marked by ActEd.  When
marking your scripts, we aim to provide specific advice to improve your chances of success in the
exam and to return your scripts as quickly as possible.

For further details on ActEd’s marking services, please refer to the 2025 Student Brochure, which
is available from the ActEd website at ActEd.co.uk.

3.4 Feedback on the study material

ActEd is always pleased to receive feedback from students about any aspect of our study
programmes.  Please let us know if you have any specific comments (eg about certain sections of
the notes or particular questions) or general suggestions about how we can improve the study
material.  We will incorporate as many of your suggestions as we can when we update the course
material each year.

If you have any comments on this course, please send them by email to CP2@bpp.com.

http://ActEd.co.uk
http://ActEd.co.uk
http://ActEd.co.uk
mailto:CP2@bpp.com
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2 Methodology

A significant proportion of the marks available for the summary document in Paper 2 are for
explaining the methodology used to derive the results that are being presented.  This includes
sufficient, appropriate description of the model purpose, data, method and assumptions.

Exam tip

Given that the summary document is written for a senior actuary who doesn’t have the spreadsheet
in front of them, it is not appropriate to simply reproduce the audit trail provided to you in
Paper 2.  Doing this is likely to score very few, if any, marks.  The summary document should
instead provide detail at a higher level than the audit trail, while still covering all the key steps.

2.1 Introduction and purpose

The summary document should start with an introduction, which explains the purpose of the
exercise, why it was carried out and what outputs are going to be analysed later in the document.

While the introduction to the audit trail may refer to the spreadsheet used to perform the
calculations, it is not appropriate to do this in the summary document.

The examples below show the first few sentences from the introductions of an audit trail and
summary document for the same project:

Example audit trail introduction extract

This audit trail relates to the spreadsheet CP2 Paper 2 Spreadsheet Model.xlsx.  The spreadsheet
determines the share price that could be achieved for our client’s initial public offering (IPO).  It
calculates the share price and proceeds four different scenarios, which are summarised in a table
and a bar chart …

Example summary document introduction extract

Our client is offering one million shares for sale to the public.  We have been asked to perform the
calculations necessary to determine the share price and total proceeds of the sale under four
different scenarios specified by the client …

2.2 Data

The summary document should explain what data was provided, where it came from and how it
was checked.  If there are any concerns about the accuracy of the data, these should also be
explained.

While the audit trail may contain detailed descriptions of the precise checks and any changes
made to the raw data, this level of detail is not required in the summary document.  Instead, the
senior actuary is likely to be satisfied with a broader overview of the corrections made to the
data.  This should demonstrate that you have taken steps to ensure the data in the model is fit for
purpose.
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2.3 Assumptions

In Paper 2, the audit trail provided in the background information is likely to contain a list of
assumptions.  There is usually a small amount of credit (eg one mark) awarded for bringing the
assumptions across from the audit trail into the summary document, as long as these are still
relevant.  However, this alone is not going to be enough to get all the marks available for
assumptions.

For the remaining marks, you will need to list a few more assumptions.  These should ‘add value’,
meaning they should be sufficiently detailed, relevant and specific to the project.  You may find it
useful to make a note of any ‘new’ assumptions as you progress through the planning and
spreadsheet update work in Paper 2.

2.4 Approach

When describing the approach taken in the summary document, you should describe the model,
not the spreadsheet.  In other words, if the model was constructed again using a software
package other than Excel, eg Javascript or Python, there should be no changes required to the
approach outlined in the summary document.  This is a key distinction between the summary and
the audit trail, as using a different software package would result in a very different audit trail.

Exam tip

The examiners have said that the summary document should ‘give a reasonable overview of the
model and the results’.  They have emphasised in particular the importance of giving a clear
description of the model itself, ie the mathematical framework used for the calculations.

So, the approach outlined in the summary document must not refer to any Excel formulae or
worksheets but should still explain the key calculation steps.  You can use the audit trail provided
in Paper 2 to help you understand the calculations that you need to explain in the summary, but
the style of both documents will be different.

The examples below show how a calculation step might be described in the audit trail and
summary document:

Example audit trail approach extract

TABLE 1 in row 3 of the ‘Calculations’ worksheet shows the number of shares bid for at each price.
This is calculated by multiplying the percentage bid for a given price by each investor (from the
‘Clean Data’ worksheet columns E to J) by the relevant number of shares bid for a given scenario
(from the ‘Clean Data’ worksheet columns O to R).  This is then summed for all investors.

Example summary document approach extract

The total number of shares bid for at each price was calculated by multiplying the percentage bids
by the number of shares and summing across all investors.
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1.4 Basic statistical functions

Function Description

MEDIAN Calculates the middle number in a set of numbers

AVERAGE Calculates the arithmetic mean

VAR.S
Gives the sample variance*, ie it estimates the underlying variance using a
denominator of 1n 

VAR.P
Gives the actual variance of a population of equally likely values*, ie it is
calculated using a denominator of n

STDEV.S
Gives the sample standard deviation, calculated as the square root of the
corresponding variance

STDEV.P
Gives the population standard deviation, calculated as the square root of
the corresponding variance

PERCENTILE.INC
Gives the specified percentile from a dataset, eg
PERCENTILE.INC (Data, 0.75) returns the upper quartile

RAND
Generates pseudo-random numbers from the continuous uniform
distribution on the range (0,1)

RANDBETWEEN
Generates pseudo-random whole numbers between a specified minimum
and maximum

* Note, when working with large data sets, it’s not vital which of the two VAR or STDEV functions
you use.
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1.5 Statistical distribution functions

Function Description

BINOM.DIST
Returns the probability or cumulative probability from a binomial
distribution for a specified value for a given number of trials n  and a given
probability of success p

NORM.DIST*
Returns the probability density or cumulative probability for a specified
value from a normal distribution with a given mean and standard deviation

NORM.INV*
Returns the value that corresponds to a specified cumulative probability
from a normal distribution with a given mean and standard deviation

CHISQ.INV
Returns the value that corresponds to a specified cumulative probability
from a chi-square distribution with a given number of degrees of freedom.
This can be used to generate critical values in hypothesis testing.

CHISQ.TEST

Returns the p-value of a chi-square test (requires the data to be grouped
and the actual and expected values for each group determined before this
function can be used – see Chapter 1 for more detail).  Note that this
function always assumes that the number of degrees of freedom is equal to
the number of groups minus 1.

CHISQ.DIST.RT

Returns the right-tailed probability of the chi-squared distribution for a
given value and number of degrees of freedom.  This can be used for
chi-square tests where the number of degrees of freedom is not equal to
the number of groups minus 1.

* The functions NORM.S.DIST and NORM.S.INV perform the same calculations on a standard
normal distribution with mean equal to zero and standard deviation equal to one.

If you require functions for other distributions, these often follow the same naming convention as
the functions above, eg POISSON.DIST, GAMMA.INV.

1.6 Other useful functions

Function Description

ROUND Rounds a number to a given number of places

ROUNDDOWN Rounds a number down to a given number of places

ROUNDUP Rounds a number up to a given number of places

ABS Returns the absolute value of a number (without its sign)

INT
Returns the integer part of a number (rounds it down to the nearest
integer)
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2 Excel functions not permitted in the CP2 exam

At the time of writing (April 2024), the minimum version of Excel that is permitted for the IFoA’s
exams is Excel 2013.  You are allowed to use most of the ‘standard’ functionality in Excel for the
purposes of the CP2 exam, however it is not permitted to use macros or functions only available
in versions of Excel released after 2013.

2.1 Functions not available in Excel 2013

If you are used to using a newer version of Excel, there may be certain functions that you have
been using that are not available in Excel 2013.  A few examples of such functions are:

 CONCAT

 TEXTJOIN

 IFS

 SWITCH

 MAXIFS

 MINIFS

 XLOOKUP

 SORT

 FILTER

 UNIQUE

 RANDARRAY

 LET

 SEQUENCE

 TAKE

If you are unsure about a function that is not listed above, you can look it up on the Microsoft
Support page, support.microsoft.com.  Here you can locate the help page for a particular
function, which should give details of the versions of Excel this function is available in.

http://support.microsoft.com
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If you are sorting data, make sure that you have captured the entire range of entries and that you
have included all other rows or columns that belong together.  For example, if you sorted the
names on your contact list – without including the phone numbers – you’d end up with a lot of
wrong number calls!

4.6 Array functions

Array functions are special types of functions that perform calculations on and output multiple
values.

An example of an array function is the SORT function, which sorts data.  To use the SORT function,
you need to select the output range that you want the function to populate, then type in your
formula.

Next, press [Ctrl]-[Shift]-[Enter] to apply the formula to the entire selected range.

When done correctly, the formula in the formula bar will be enclosed in curly brackets, signifying
that an array function is being used.

You cannot invoke an array fucntion by manually typing curly brackets around a formula.  It can
only be done using [Ctrl]-[Shift]-[Enter].

Any Excel function can be applied as an array function.  However, the following useful functions
can only be used as array functions.
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Function Description

SORT Sorts data from smallest to largest, or from largest to smallest

TRANSPOSE
Swaps the rows and columns of a matrix, or converts a row array into a
column array (or vice versa)

MMULT Multiplies two matrices together

FREQUENCY
Counts the number of values in a dataset falling in different ranges (useful
when doing a chi-square test)

MINVERSE Finds the inverse of a square matrix

Be careful using array functions on very large datasets.  They can be memory-intensive and slow
to calculate, and in extreme circumstances could cause Excel to crash.

A word of warning – ‘SPILL’ functionality

Newer versions of Excel (2016 onwards) contain functionality to produce automatic (or dynamic)
array formulas.  This behaviour is known as ‘spilling’.  We can see this in action using the SORT
function example above.

This time we select a single cell and key in our formula as before.

Then if we press Enter we get the following:

In this case, Excel has identified that we require an array output and has generated it
automatically.  We can see that SPILL functionality has been invoked because the array output is
surrounded by a blue outline and the formula bar is now greyed out.
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Unfortunately SPILL functionality is not backwards compatible to Excel 2013, and if a spreadsheet
containing it is opened in an old version of Excel, the spilled numbers will be converted to
hard-coded values.  To avoid this problem in your exam, use the traditional (also know as ‘legacy’)
array formula method described above.

4.7 Filtering

Excel allows you to filter the records in your data so that it only displays a subset, eg only female
employees based in the UK or the Republic of Ireland.  To access this feature, highlight a range of
cells or the letter(s) at the top of the column(s) you want to filter, then select Data > Filter.  You
can now click on the drop-down filter menus to select the subset you require.

You can also use this feature to identify any rogue entries in your data.  These will be listed in the
drop-down menus.

Note that, when a filter is applied, the summary calculations shown at the bottom of the screen
and any copying you do will now only include the filtered records.  So don’t forget to turn the
filtering off when you’ve finished with it.

4.8 Paste by value

Formulae in Excel are dynamic, ie if you change one of the inputs, the output values will be
recalculated automatically, based on the new input value.  This is one of Excel’s great strengths –
but sometimes it’s not what you want.  For example, if you’re doing a simulation using random
numbers, you might want to preserve a particular set of results.

To achieve this, you can use the ‘paste by value’ feature.  Select and copy the cells in the normal
way, but then use Home > Paste > Paste Values > 123.  Excel will then copy the actual numerical
answers, rather than the formulae.  These answers will then be ‘frozen’ – they won’t change if
you change any of the input values they were originally based on or if you use the recalculate
feature (ie press the [F9] key) to run another simulation.

Avoid using the ‘paste by value’ feature in other circumstances, as it requires manual intervention
if changes are made subsequently.

4.9 Goal Seek

Suppose that you wish to find the interest rate for which the annuity factor calculated as
  101 (1 )i

i
 is equal to 7.  You can use Excel’s ‘Goal Seek’ feature to solve equations such as this

that cannot be solved directly.  To access this feature, select Data > What-If Analysis > Goal Seek.
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2 Typing mathematical formulae (‘equations’) and Greek letters

It’s unlikely that you will need to reproduce any complicated mathematical formulae in your audit
trail or summary document.  It’s usually better to explain the methods you’ve used in words.
However, in some situations, you might need to type some mathematical symbols or simple
formulae.

Note that, unless you have specific access arrangements agreed with the IFoA, you can only use
standard functions available in Microsoft Office 2013 for the completion of the exams.

Inserting symbols and equations

You can directly insert Greek letters or mathematical equations within Word using the Insert tab
on the Ribbon.

Math AutoCorrect

You can use shortcuts to enter Greek letters and mathematical symbols by turning on ‘Math
AutoCorrect’.  To do this go to the File menu, open the Options menu, select Proofing from the
left-hand list and then the button AutoCorrect options.  Choose the tab Math AutoCorrect and
tick the box at the top to turn this on.  You can see a list of the shortcuts available.  This can be
quicker if you are familiar with the shortcuts.

Mathematical mark-up languages

Using the Equation Editor function within Word to produce mathematical formulae and symbols is
allowed.  However, you are not allowed to use other mathematical mark-up languages in the CP2
exam (or any of the other IFoA exams).  For example, LaTeX, MathML or Open Math are not
permitted.  Using these could corrupt your exam script file meaning the examiners are unable to
mark it.
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Assignment X2 – Solutions

The Excel component of the solutions and marking schedule are provided through our virtual
learning environment, ‘The Hub’.  These are provided either:

 in the CP2 Assignment Solutions course on The Hub at bpp.com/account, if you have not
purchased Series X Marking, or

 in the marking course on The Hub where your work was (or should have been) submitted,
if you did purchase Series X Marking.

If you purchased Series X Marking and requested to have access to the solutions before
completing the assignment, then solutions are accessible from both locations.

If you have previously used The Hub then just log in with the same username and password.  If
this is your first time using The Hub then you will have been sent an email with your login
information (please check your spam / junk folder if you can’t find it).  More information on
logging into The Hub is given on the ActEd website at ActEd.co.uk (Help and Advice, Further
information, Logging into The Hub).

Purpose

The purpose of this spreadsheet is to project the cash flows, unit and non-unit funds for the
proposed unit linked savings product.  The spreadsheet covers three premium options:

 lump sum single premium of $10,000

 monthly premiums of $50

 monthly premiums of $100.

The product has a term of 10 years for all premium options.

Parameters

The parameters are contained on the “Parameters” tab.  The parameters used are:

 the bid-offer spread and fund management charge (FMC) charged to the policyholder

 the initial and regular expenses, and regular expense inflation

 investment expenses

 investment returns for the unit and non-unit funds

 the risk discount rate

 the lump sum and regular premium options.

The parameter input cells are coloured yellow.  The parameter cells are named for ease of
modelling.  The range names are displayed next to the parameter inputs.

http://bpp.com/account
http://ActEd.co.uk
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Assumptions

The following assumptions are made:

 The only policyholder charges on the product are the bid-offer spread and FMC.

 Assumed initial and regular expense levels are reasonable.  Increases to regular expenses
are applied each month.

 Investment expenses on the unit fund are calculated based on the value of the unit fund
before the deduction of the FMC.

 The expected investment returns can be achieved in practice.

 The risk-discount rate provided is appropriate.

 Investment returns and expense inflation are fixed over time.

 The product only offers a term of 10 years.

 It is not necessary to consider tax for the purposes of the modelling.

Calculations – lump sum option

The calculations for the lump sum option are on the “UL projection (lump sum)” tab.  “One-off”
cells (where a calculation is different from the rest of the column) are coloured blue.

Columns B to G contain the monthly cash flows and projections for the unit fund.  The calculations
for the unit fund are constructed as follows:

1. The first column shows the premium paid.  For the lump sum option there is only one
premium paid at the start of the first month.  This is equal to the “Lump sum” parameter.

2. The next column calculates the bid-offer spread by applying the charge to the premium.

3. For the first month, the premium paid net of the bid-offer spread is the unit fund at the
start of the month.  For the second and subsequent months, the unit fund at the start of
the month is the premium paid net of the bid-offer spread plus the unit fund at the end of
the previous month (after deduction of the FMC).

4. The unit fund balance at the start of the month is rolled up at the relevant monthly rate
determined from the annual unit fund growth rate to the end of the month.

5. The FMC is calculated using the FMC parameter, converted to a monthly rate, multiplied
by the unit fund value at the end of the month.

6. The FMC is subtracted from the unit fund at the end of the month and this value is read
into the next row as the unit fund at the start of the following month (in line with step 3
above).

Columns I to O contain the monthly cash flows and projections for the non-unit fund.  The
calculations for the unit fund are constructed as follows:

1. The first column shows the bid-offer spread, which is taken from the unit fund calculation
step 2 above – this is added to the non-unit fund at the start of the month.
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2. For the first month only, initial expenses are subtracted from the non-unit fund at the
start of the month.

3. The non-unit fund at the start of the first month is the bid-offer spread minus the initial
expenses.  For the second and subsequent months, the non-unit fund at the start of the
month is the bid-offer spread for the month plus the non-unit fund at the end of the
previous month.

4. The FMC taken from the unit fund is shown as an input to the non-unit fund.

5. Regular expenses are calculated by calculating the monthly expense (annual expense
divided by 12) and then increasing this for the appropriate period of inflation since the
start of the projection period.

6. Investment expenses are calculated based on the unit fund at the end of the month
(before the FMC is deducted) and the monthly rate determined from the annual
investment expense parameter.

7. The non-unit fund at the start of the month is rolled up at the relevant monthly rate
determined from the annual non-unit growth rate.  The FMC is added to this and both
regular and investment expenses are deducted to calculate the non-unit fund at the end
of the month.  This value is read into the next row as the non-unit fund at the start of the
following month.

The following automated checks are included in columns Q to S:

 The total premiums paid in the projection are compared to the lump sum premium paid.

 The total bid-offer spread charged in the projection is compared to the single premium
multiplied by the bid-offer spread.

Calculations – regular premium options

The calculations for the regular premium options are in the “UL projection (reg prem 1)” and “UL
projection (reg prem 2)” tabs.

The calculation is the same as for the lump sum single premium option with the following
changes:

 The premium paid into the unit fund occurs every month at the levels determined by the
“Regular premium 1 (pm)” and “Regular premium 2 (pm)” parameters, as appropriate.

 The automated checks on premium and bid-offer spread are applied to 120 regular
premiums rather than the single premium.

Note that if future calculations are performed for a different policy term, the automated checks
will need to be adjusted to account for the number of premiums being different (ie not 120).

Calculations – summary

In the “Summary” tab, the table in rows 2 to 5 summarises the present value of profit to the
insurer.  This is calculated by taking the value of the non-unit fund at maturity from the underlying
calculation tabs and discounting back to the start of the projection at the risk-discount rate.
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Note that the term of the discounting is set to 10 years.  If future calculations are performed for a
different policy term, the term of the discounting will need to be adjusted.

The table from row 8 downwards summarises the projected value of the non-unit fund
throughout the 10-year projection period from the underlying calculation tabs.  This projection is
shown in the accompanying chart.

Reasonableness checks

For the lump sum, the non-unit fund is projected to increase over the term.  This is reasonable
since the initial bid-offer spread is enough to cover initial expenses, and ongoing charges are
enough to cover regular and investment expenses, so this premium option is profitable at every
time period.

The regular premium options start off with a negative non-unit fund.  This is reasonable as there
are no significant up-front charges to cover initial expenses, so these options are initially
loss-making.

The $100 option non-unit fund projection grows and eventually becomes positive.  This is
reasonable because the FMC and bid-offer spread are enough to cover regular and investment
expenses and contribute to covering initial expenses as the fund grows.

The $50 option non-unit fund projection never becomes positive.  This is reasonable because the
invested premiums never contribute enough to the FMC and bid-offer spread to cover the initial
expenses.
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The TAX CALCULATIONS section calculates the amount of income falling in each of the tax bands
for workers on each pay level.

The first column (shown in red) has a slightly different formula. It calculates the minimum of the
Average Income from the Population tab and the width of Band 1.

The subsequent columns calculate the minimum of {Average Income minus the sum of the
amounts in the lower bands} and the width of the current band.

In the RESULTS section the Tax is calculated by applying the tax rates to the figures in the previous
columns using SUMPRODUCT.

Avg rate is the average tax rate paid by workers on that income level. It is calculated by dividing
the previous column by the Average Income for that level.

Below the calculations for each income level, the total tax collected is calculated in millions.  This
is done by multiplying the tax at each income level by the number of people at each income level
from the PARAMETERS worksheet.

Finally, the average tax level for the population is calculated by dividing the total tax collected by
the total population income from the PARAMETERS worksheet.

CHECKS

 The total income for all bands is calculated for each level in Column G and compared with
the Average Income column in the Population tab to ensure the amounts allocated are
correct.

 Checks are included below each column in Row 18 (calculated using a MIN function) to
ensure that there are no negative entries.

WORKSHEETS ‘System1/2/3/4’

These tabs carry out the calculations for the proposed alternative tax systems.

The calculations are the same as in the System0 tab, but using the appropriate parameters
specified on the Parameters tab.

RESULTS

This tab collates the results from the various systems and includes two graphs.

The entries in the first part of the AVERAGE TAX RATE table are linked directly to the RESULTS
section in the corresponding SystemX worksheet.  These are plotted in a clustered column chart.

The entries Avg rate and Tax values are also linked directly to the appropriate SystemX tabs.
These look up the average tax level and total tax collected (in millions) for the population.

The Change is calculated by subtracting the original tax amount under the current system
(System0) and these values are plotted in a column chart.  Note that the display units for the
vertical axis have been set to ‘Thousands’ to display the figures in billions.
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